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PURPOSE.:

To guide the administration of referrals within the Las Vegas TGA’s Ryan White Part A
Program. It is the intention that appropriate and timely referrals assist clients in accessing and
maintaining core medical and supportive services. The intention is for referrals to be completed
consistently among all Ryan White Part A funded agencies.

POLICIES:

Referrals are to be completed within the CAREWare database. Faxed referrals are no longer accepted.
There are two types of referrals within CAREWare: internal and external. Internal referrals are
made between providers within the Ryan White Part A provider network via CAREWare
electronic transmittal and upload of scanned referral documents. External referrals are referrals
made to non-Ryan White Part A funded agencies and are the responsibility of the referring
provider to track or resolve. Ryan White Part A funded agencies are only required to enter in
CAREWare internal referrals.

Internal Referrals

Responsibilities of Provider Making Internal Referrals

It is the responsibility of the referring provider to check client’s Ryan White Part A eligibility
prior to making any referral. Referring providers are to complete all the required data fields in
the CAREWare Referral, as well as scan and upload all necessary documentation to the
Referral Attachments area. Providers making referrals are expected to contact the agency, they
are referring to for their current referral policy.

The referring provider must ensure the specific purpose of the referral is clear. Incomplete or
inappropriate referrals may be rejected at the discretion of the provider receiving the
referral. Internal referrals must be documented in CAREWare within 5 days of the client
encounter. Any referrals documented in CAREWare more than 5 days from the client encounter
must be pre-approved by the grantee office.

It is the responsibility of each provider to track the status of the referrals they make (completed,
rejected, lost to follow-up), and notify the client accordingly.

Responsibilities of Provider Completing Internal Referral

It is the responsibility of all providers receiving referrals to address all incoming internal
CAREWare referrals in a timely manner. Incoming Internal Referrals can be found under
System Messages listed under the Main Navigation Menu. Providers completing/receiving
referrals must verify client’s Ryan White Part A eligibility prior to completing all referrals.
Clients shall be contacted by provider completing referral within 5 business days of receiving all
necessary referral documents. Clients shall receive an appointment with the receiving agency
within 30 days of being contacted.

Providers receiving internal referrals are responsible for updating the Referral Status in
CAREWare, entering a Referral Complete Date, as well as the Name of employee completing
referral. Referrals are considered complete when an appointment has been scheduled, check has
been issued, or other applicable item/service has been prepared.



Providers marking incomplete or inappropriate referrals as “Rejected” must indicate Name of
employee completing referral and clearly state reason for rejecting referral in the Comments
from employee completing referral field.

All internal referrals should be resolved, e.g., Referral Status changed to “Completed, Lost to
follow up, or Rejected,” within 30 days. A minimum of three attempts must be made to contact
the client prior to changing the Referral Status to “Lost to follow up.”

External Referrals
External referrals made to non-Ryan White Part A providers must be tracked/resolved by the
agency making the referral. As with internal referrals, providers have 30 days to mark outgoing
external referrals as complete.
e It is the responsibility of the referring provider to track, resolve and complete these
referrals.
e Ryan White Part A funded agencies are only required to enter in CAREWare internal
referrals.

For more information on making and completing referrals, please see Ryan White Part A Referral
Procedures guide or contact the grantee office.



PROCEDURES

All internal referrals are to be made in CAREWare. This includes sending a CAREWare internal
referral and scanning and uploading all applicable referral documents to CAREWare. External
referrals can also be entered in CAREWare but are not required. It is up to each agency to decide
whether to enter external referrals. The procedures for making internal referrals, completing an
internal referral, entering external referrals, and using the outgoing referral queue are detailed
below.

Access client account and verify eligibility
1. Loginto CAREWare and go to the account of the client for whom you are making a referral.

2. Verify that the client is currently eligible before proceeding.

Find Client > Search Results > Demographics
@® Customize
Demographics
Client Report
Encounter Report ’D em 09 ra Phi cs
Drug Paymants
e Parsaonal Info Client ID; Mame: testin I:-Iianl(/— . \‘
Annual Heuiaweh‘__q‘ﬁ_ e Go to the client account.

Case Notes

Dadete Chenlt  Back

CITSMT51A

Verify eligibility is current
P bylooking at
Contactinformation |5 yegae Ny 80102 * Annual Review

Vital Signs
Hospital Admissions
Medications

Labs / Eligibility
Screanings Race/Ethnicity T + Common Notes &

3'3'“"_'"9_"“'5 ¢ Attachment Documents
Immunizations HIW Rizk Factors [[ull}

Diagnoses
Sharing Reguests
Refamrals
Relations
Counsaling and Tasting Eligibility
Pragnancy History
COrdears

EIS - Linkage to Cara
Hepatitis Quastionnaira .ﬁf’
Appointmants Common Noles
User Messages

Search Changs Details Provider Notes
Duplicate Cliant

Vital Enroimant Siatus /2019 Current Status: Active

HIV Siatus -positive (npd AIDS) HIV Date: 06152017

description supplied

Parformance Maasure :
Sratus Attachment Documents View or Edit the client's Attachment Documents information

Close Referral Documents View or Edit the client’s Referral Documents information

RWISE View or Edit the client's RWISE information

Walcome to PART A




Prepare the Scanned Referral Document Packet
When uploading a scanned document packet, ensure that:
M All pages are saved and uploaded as 1 PDF file
M There is only 1 PDF file for 1 referral
M The referral cover sheet is the first page of the PDF file
M All pages are face up, in the same direction, and legible
M All required documents are included per the agency’s referral policy

3. Only referral-related documents should be scanned and uploaded to the Referral Attachments
area. Ensure that documents are current and within 5 days of the client encounter. Please
consult the agency you are referring to for information on their required referral documents.

4. When scanning, all pages must be face up and face the same direction. Make sure any
documents with small print, such as ID or insurance cards, are enlarged so that the text is
legible.

5. Scan all referral documents as one PDF file. CAREWare can only accept PDF files. Clearly
label the file with the client name, referral type, and date. For example:
“ClientName HousingAssistance 07-22-2020”

Each scanning and computer system is different. If you have questions on how to scan to your
computer, consult with your IT staff.

Upload Scanned Referral Packet to CAREWare
6. When you are ready to upload your file to CAREWare, go to the Attachment Documents
button.

Aftachment Documents

7. Select the Attachments link listed next to Referral Attachment, if available, this link will list
the number of existing attachments. Example: 4 Attachments

Find Client* Search Hesulls * Demographics > ARachmen? Docwments I Fiind Clagnt > Search Results > Dy hics > Aftach Ix

R You cannot open the links __,r'*'-':'_ ol
Attachment Documents| if your screen says save. Attachment Documents
Elgetality Anachment: [AMICHMENES (ACoe=T T Ve T iy Elgibility Attachment: 0 Alachments [Acoss s view mods only

Reterral Amschmsnt: D AMIChmenls (ACoess in virs mode only Lab Attachment: 0 Attachments (Acoess inview maods only

Lab Amschmsnt: [ AMChmenls [ACKESS in virs mode only Processed HIP Invoices: 0 ATAChmEnts (SC0ess i vew mode only

Processed HIP Invoices: [ AIBchiments (Accesy v Sode only Denial Tresenen] Plan: 0 AMSCHMENTS |(SE08A B vt mooe onily|

Dental Treatment Plarc  (ATRCHMENES (ACCESE in v izl HIP Denisls: 0 Aftachments [Acosss is view mode only|

HIP Denials: D ARICHMSNES (ACCERS in v

Be sure you're attaching Referral Attachment: 2 Mtachmenty [Access in view made oy
to Referral Attachment, His cument signed RO
thE.' E:-rde:l’ may tl-E d:ifferEﬂt Care Plan Attschimeat: 0 ARSChimenily (Scomed i i maods ol

Fas currend sigesd RO
Care Plan Anschmsnt: 0 AMIchments (Acoess in v

-




8. Click Add from the option menu.

Find Client > Search Results > Demographics > Attachment Documents > 0 Attachments

View Edit Delete Link Back Print or Export

Attachments

Search: |

Conten Attach Dtate Attach User Mod Date Mod User Fi File Name

9. Click the Choose Files Button to select the document you’re wanting to upload.

Find Client > Search Results > Demographics > Attachment Documents > 0 Attachments > Add

Mext Back

File Name(s}: | Choose Files | MNoffile chosen

10. A screen with your computer files will appear.
a. Navigate to the folder/place you scanned/saved the referral packet
b. Select the document (it will become highlighted, and the name will populate in the
filename field)
c. Select Open

E;' Open %
“ w A » ThisPC » Desktop » Test Documents w =]
Organize = Mew folder « [ ﬂ
-~ [ p— ’ R O -
b [ Thic P [ Mame Diate modifie
B 30 Obpects Scanned Dogumaents
B Desktep \ %] Blank Letterhead in 'Werd.docx
A o 5 — 170 ond Adobe Acrobat I o3 KB
— Doguments A4 ClientTesting_HousingAssistance_I7-0... I dobe Acrobat D... E
& Downlosds
J‘ Music
= Pictures
T -
File namee: | ChentTesting,_Hous ngissistance 07-01-2020.pdf &l Files (*.%) w

3

11. Once the attachment has been successfully uploaded, select Next

Find Client > Search Results »* Demographics = Attachment Documents > 0 Attachments > Add

Back
Add

File Name(s): | Choose Filas | ChentTestin._.01-2020 pdi  Upload Completed Successfully. [503.13 KB of 503.13 KB)




12. Use the Magnifying Glass next to the Content Type to look for the name of the agency you
are referring to and the type of service. Please contact the grantee’s office if you are unable to
find the appropriate service type.

Find Cheml > Search Results * Demographics > Amschment Documents * § ARachmenls » Add > Nexl

Next
4 Fage ' Ny 2 =S Rt
Comtent Trpe: J |n - -' e charsclers b seaech thiough 36
Commant: - Buss Passee
Diatitizn
EFA
HIG

- Housing Ascistanie
- Mental Haalth
Case Management
Madisa

Hafara

Case Managamani

13. Include any important information in the comment field and click Save when you are done.

Find Client > Search Results > Demographics > Attachment Documents > 0 Attachments > Add » Next

Next
ClientTesting_HousingAssistance 07-01-2020.pdf
Content Type: | - Housing Assistance
Comment: | Fast Due on Rent

14. From the Attachments Screen you can see your uploaded document.

Find Cliend > Search Results > Demographics > Attachment Documents > 0 Atlachmsnts
Add  Edit  Delats nk Back Print or Export
Searct
Conlrm Tywe AT DT AU XTI RRA DO UGS R IFNE TR maen AT

15. Verify that the packet uploaded correctly by selecting the file from the list and then clicking
View from the menu.

Find Client > Search Resulis > Demographics > Attachment Documents > 0 Attachment

.-'-'u."l:J Edit Delete Link Back Print or Export

Attachments




16. Here you can view the packet by click on the File Name.
a. The document will open. Depending on your computer settings, it will open in a new
browser window, OR in Adobe.
b. When finished, viewing, click Back
1. To edit the comment, click Edit

I g Cligiit & Sadich Ricsiills > Demographics > ANs: hineal ocussnts > 0 AN = Ve

View

Fils Wamé:  CheniTesting_HousingAssistance_07-01-2020.paf —
Conbant Type: Housing Assistance
Comment:  Fast Dud on Rant

@ Chenfeming Houtinglsisanc: M o

& & higaowdjprog.nat A lzcigldtnfatt pid... o [l ™ * =

***Uploaded documents can only be deleted by the Grantee’s office. If a document is
uploaded in error, please contact Linda Montgomery to delete. ***



Making an Internal Referral
The following CAREWare fields must be completed in the Referrals form for all internal
referrals. These fields will be completed in two steps:

These four fields are completed when setting up the referral
M Date
M Type
M Provider
M Service Category

These three fields are updated prior to submitting to the next provider
M Referral Class
M Name of employee making referral
M Comments from employee making referral

After you have uploaded and reviewed your referral document packet, you must create an
internal referral in CAREWare. This notifies the provider that a referral is waiting for them.

17. Click Referrals from the Navigation Menu

'ﬁ' Customize
Demographics

B The available menu options may be
Encounter Rapont | different depending on your specific
Drug Payments user permissions and agency set up

Sarvicas
Annual Rewview

Case Notes

Vital Signs

Hospital Admissions
Medications

Labs

Screenings

Screening Labs
I aons
Diagnoses

Sharing Requesis
Helations

Counseling and Testing
F'rugn.:-‘llll_",' H:stul:,'
Ovdears

EIS - Linkage to Care
Hepatitis Questionnaire
Appointments

Usger Messages
Search Change Details
Duplicate Client

Pearformance Measure
Status

Closa




18. Select Add from the menu.

Find Client > Search Results > Demographics > Referrals

View Delete Referral Classes  External Provider Setup  Print or Export

Referrals

Search:

Dir Referral Date Provider Service Category Status Complete Date

19. Complete the fields as required:

a.
b.

C.

the date vou enterthe
( Make sure to select ) referral in CAREWare.

Internal asthe
referral type. If

vou select Date: |7/15/2020

External, the

prm-'iderr}nu are —-W Internal
sending the

referral to will Provider:

|
\not see it. /Cﬂtﬂﬂﬂwl | ¢T~. //

Date — Today’s Date

Type — Internal

Provider — Use the Magnifying Glass to search for the Provider receiving the referral
Service Category — Make the appropriate selection based on your referral need

When complete, select Next

Find Client > Search Results > Demographics > Referrals = Add

Back The Referral Date is

»
214

Select the appropriate service Select the prcrvi_der
category. Once vou choose you are referring
this, the remaining referral to from the drop-

fieldswill appear. down menu.




20. On this screen you will need to complete the following fields, the other fields will be greyed
out. If a greyed-out field needs to be change, click Back

a.
b.

C.

Class — Use the Magnifying Glass to search for the best option

Comments - Leave this blank

Name of employee making referral — Select your name from the drop down
Comments from employee making referral — Add comments regarding
client/referral

Name of employee completing referral - Leave this blank

Comments from employee completing referral - Leave this blank

Next

Find Client > Search Results » Demographics > Referrals = Add > Next

Save Back

Name of employee making referral- | BF.._\

Comments from employee making referral

Choose the option
that best fits from the
Referral Date:  7/19/202C referral class drop
From Provider- | Referring Provider down.

Provider.  Refer-To-Provider
Direction: Juigeing
Category Label: Emergency Financial Assistance
Status:  Pending
Complete Date:

Silent: ]

Class:

I
Comments: ‘ z Z ‘

Emergency Referral: |

Select vour name from the drop
down. If you do not see your
name, contact the grantee’s
office to be added.

‘ v
Name of employee completing referral: | ;ﬂ, P
Comments from employes completing referral In this section,

describe the purpose
of the referral and
include any

These fields are entered by the provider ] additional

completing the referral. ) 11nf0rmat10n.




21. Once you have completed the applicable forms, select Save

Referrals = Edit
Save Cancel
Referrals
Referral Date; 7/22/2020
From Provider: Referring Provider
Provider: Refer-To-Provider
Direction: Cutgoing
Category Label: Health Insurance Program (HIP)
Status: Fending
Complete Date:
Silent: L
Class: |ADAP
Comments: . i i
Name of employee making referral: | Emplovee A [ 4 |

Emergency Referral: L1

Comments from employee making referral: | Additional information, Important Notes forall to know

MName of employee completing referral: |

Comments from employee completing referral:

22. Your new referral will display as shown below. If you need to make any changes, select
View and then choose Edit

View | Add Delete Referral Classes External Provider Setup  Print or Export

Referrals
Search: ‘
ra
Direction Referral Date Provider Service Category Status

Outgoing 07/22/2020 Provider Agency Health Insurance Program (HIP) Pending




Managing an Internal Referral

If you are a provider who receives referrals, you will use the CAREWare incoming referral list to

receive notification of new referral requests.

1. From the main menu, select System Messages (this blinks a very light to light grey when

messages are available)
2. Select Incoming Referrals

System Information
[ System Messages ]

QOutgoing Referrals

You have pending outgoing referrals

4 N
If the Incoming

® customize System Messages referrals button is
Add Client Cancel missing, don’t worry!
Find Client It just means you have
Reports @System Messag( no incoming referrals
Rapid Entry right now.©
Appointments _ 7 \ : : /
My Settings Incoming Referrals You have pending incoming referrals

Administrative Options
Switch Providers
Log Off

Administrative Alarms 1082 total alarms unacknowledged

User Messages View/Acknowledge User Messages

Clark County CAREWare 6 -
Build 72

3. From the list of Pending Incoming Referrals. Select the record you want to view, and then
click View Details .

Pending Incoming Referrals
View Details | Pnint or Export

Pending Internal Referrals

Search: | test
Referral Date Name Date of Birth Gender Requested Service Referring Provider Client 1D
0712212020 client testing 111975 Male Health Insurance Pr Provider Agency

You will be taken to the Referrals section. Before proceeding, verify that the client’s Ryan
White eligibility is current by checking the Annual Review, Eligibility, Common Notes,
Attachment documents. [z is the responsibility of both the person making the referral and
the person completing the referral to verify eligibility.

a. When viewing the documents, keep the documents related to your referral open or
print them for reference. You may need to refer to the documents when working and
completing the referral.



5. Once eligibility has been verified, go back to the Referral by selecting Referrals from the
navigation menu.

Medications

Labs

Screenings

Screening Labs

Immunizations

Diagnoses

Sharing Requests

Referrals

Relations

The available menu options
may different depending on
your specific user permissions

Counseling and Testing
Pregnancy History
Orders

EIS - Linkage to Care
Hepatitis Questionnaire
Appointments

User Messages

6. To access (view/edit) the referral, Select the record from the list, and click View.

Demographics > Referrals

Add Delete Referral Classes External Provider Setup  Print or Export

Referrals

Search:|

Direction Referral Date Provider Service Category Status C
Incoming 07/22/2020 Provider Agency Health Insurance Program (HIP)  Pending

7. View the Category Label, Class, Comments, and Name of Employee Making Referral fields
to get more information and the purpose of the referral. \

8. Once you have determined how to proceed, and are ready to edit the referral, select Edit

Referrals » View

Edit | Back
View

Referral Date:  7/22/2020

From Provider:

‘ Name of employee making referral:

Referring Provider

Provider: Refer-To-Provider
Direction: Ouigoing
‘ Category Label: Health insurance Program (HIF)
Status: Fending
Complete Date:
Silent:
Class: ADAP
Comments: -Additional information, Important Notes for all to know

Employee A




9. On this screen you will need to complete the following fields, the other fields will be greyed
out and unable to be edited.
Status — Edit accordingly (see next step)

b. Class — Do not edit

c. Comments - Do not edit

d. Name of employee making referral — Do not edit

e. Comments from employee making referral — Do not edit

f. Name of employee completing referral - — Select your name from the drop down

g. Comments from employee completing referral — Add comments regarding

client/referral. Be sure to add comments based on Status selection as detailed in next

Step
Find Client > Search Results > Demographics > Referrals > View > Edit
Save Cancel
Edit
T ™~
Referral Date: 77222020
/ . \ T . . Choose the date
Choose the option From Provider: Referring Provider accordingly
tﬁat b{feSt zissﬁ‘om Provider: Refer-To-Provider based on the
the referr tatus
Direction:  Incoming Statl.ls
drop down. y
r 1 Category Label: | Health Insurance Program (HIP
Pendincl 3 cotue: [Foning -
P Complete Date: | j-/
Lost io follow up .
Silent: |_|
Pending
Class:

. [ADAP
\ Rejected /
L Comments: ‘ ‘

Emergency Referral: |

i: [ Employee A

T R e I ‘ Additional information, important notes for all to know

Name of employee making

]

These fields are entered by the
referring provider.

Name of employee completing referral: -
L3

Comments from employee completing referral: \

In this section, Select your name
describe the purpose from the dropdown.
of the referral and If you do not see
include any your name, contact
additional ) the grantee’s office

kto be added.

information.




10. You will need to update the applicable fields accordingly.
h. Status — Use the dropdown arrow to select the appropriate status

Status: E IB

i. Pending — If you are waiting for additional documentation or information,
leave the referral as Pending.
1. Complete Date: Leave Blank
2. Comments from employee completing referral: Add dated comments
detailing steps needed to complete referral
ii. Completed — If you were able to schedule an appointment, issue a check, or
prepare the applicable item/service, mark the referral as Complete. To be
considered Completed we are only looking at if all the applicable items were
prepared. Services entered under the Service section will be used to
determine if the client actually received services.
1. Complete Date: enter the date you prepared all items. This will most
likely be different than the date the client receives the service.
2. Comments from employee completing referral: add dated comments
iii. Lost to Follow-Up — If you are not able to contact the client or obtain the
necessary items to complete a referral within 30 days of the Referral Date,
select Lost to follow-up. A minimum of three attempts must be made to
contact the client, prior to changing the referral status to Lost to Follow-Up.
1. Complete Date: enter the date you determined the referral to be Lost to
Follow-Up.
2. Comments from employee completing referral: Dated comments of
each outreach should be documented
iv. Rejected — If the referral does not make sense, e.g. a request for a service your
agency does not provide, referral purpose is unknown, or a referral that was
entered more than 5 business days after the client encounter, select Rejected
1. Complete Date: enter the date you determined the referral to be Lost to
Follow-Up.
2. Comments from employee completing referral: add dated comments
of why you rejected the referral.
3. Name of employee completing referral: Select name from dropdown
i. Name of employee completing referral: Use the magnifying glass to select your
name from the dropdown
11. Verify you form fields are filled out completely and accurately.
12. Select Save

View Details > View > Edit

Edit

Referral Date: 7222020




13. The Referral Status & Completed Date are now updated, and the provider who sent the

referral will be able to access the information you entered. If you left the Referral Status as
Pending remember to go back into CAREWare to update the status when appropriate.

View Details

View Add Delete Referral Classes Extarnal Provider Setup Print or Export

Referrals

Sesn:}::l |

Direction Referral Date Provider Service Category = Complots Dot
Incoming 0772212020 Provider Agency Health Insurance Program (HIP.  Completed

Making an External Referral

1.

External referrals are a way to track client referrals sent to non-Ryan White Part A providers.
They are unable to bee seen by other providers and can only be completed by your agency.
The Ryan White Part A Grantee’s office does not require entry of external referrals in
CAREWare, and it is the agency’s decision whether to enter external referrals. It is your
agency’s responsibility to resolve all external referrals within 30 days

Click Referrals from the Navigation Menu

9 Customize

D hi . .
e The available menu options may be
Client Report

Encounter Repot | different depending on your specific

Drug Payments user permissions and agency set up
Services

Annual Review
Case Motes

Vital Signs
Hospital Admissions
Medications
Labs
Screenings
Screening Labs
Immunizations
Diagnoses
Sharing Requests
Referrals

elations
Counseling and Testing
Pregnancy History
Orders
EIS - Linkage to Care
Hepatitis Questionnaire
Appointments
User Messages
Search Change Details
Duplicate Client
Perfarmance Measure




2. Select Add from the menu.

Find Client > Search Results > Demographics > Referrals

View Delete  Referral Classes  External Provider Setup  Print or Export

Referrals

Search: |

=
Dit Referral Date Provider Service Category Status Complete Date

3. Complete the fields as required:
a. Date — Today’s Date

b. Type — External
c. Provider — Use the Magnifying Glass to search for the Non-RW Provider receiving
the referral
i. Ifthe provider you are looking for is not listed, please contact the grantee’s
office to have your provider added as an option
d. Service Category — Make the appropriate selection based on your referral need
e. When complete, select Next

Find Client > Search Results > Demographics > Referrals > Add
Back The Referral Date is
the date you enter the
A d d referral in CAREWare.

Mak: o e

to Se‘l‘ﬁtﬂe Date: |7/27/2020 5

External as

the referral Type |E:-:terna1 B

type. Provider: | 1_0
e

-

£

Service Category: |/

Select the appropriate service Select the provider

category. Once you choose you are referring

this, the remaining referral to from the drop-
down menu.

fields will appear.




4. Complete all remaining information as required by your agency’s policies and procedures

Find Client > Search Results > Demographics > Referrals > Add > Next

Save Back

Next

Referral Date: 772772020
From Provider: Referring Provider
Provider: Refer-To-Provider
Direction: CQuigoing
Category Label: Food Bank/Home-delivered Meals
Status: [Pending 53

These fields should be
completed as required
by your agency.

Comments:

Name of employee

Comments from employee m

Name of employee completing referra

Comments from employee completing referral:

5. Select Save
a. The Referral Status must be resolved to Pending, Lost to follow-up, or Rejected
within 30 days of the Referral Date.

Managing an External Referral
If you are a provider who creates external referrals, you will use the CAREWare outgoing
referral list to keep track of the pending/in-progress referral requests.

1. From the main menu, select System Messages (this blinks a very light to light grey when
messages are available)



2. Select Incoming Referrals

o~

® _ S If the Outgoing )
Customize Referrals button is

Add Client Cancel issi ’ !

: missing, don’t worry!
Find Client It just means you have
Reports .System Messag no external referrals
Repad Sty right now. ©
Appointments
My Settings Incoming Refemals ‘ou have pending incoming referrals
System Information V»;

1 Messages Outgoing Referrals You have pending outgoing referrals

Administrative Options
Switch Providers

Administrafive Alarms 1082 total alarms unacknowledged
Log Off }

User Messages View/Acknowledge User Messages

Clark County CAREWare 6 -
Build 72

3. From the list of Pending Outgoing Referrals. Select the record you want to view, and then
click View Details .

Pending Outgoing Referrals
Pending Outgoing Referrals

Search: |les] |

R.ul'an'alvnm Mame Date of Birth Gender Client 1D Requested Service Referred To Provic Referral Type
07272020 client festing 1MASTS Iale Food Bank/Home-d Provider Agency B Extemal
0g2172018 Client Tast BMT2000 Female Eligibility RWISE Imtarnal

4. To access (view/edit) the referral, Select the record from Pending Outgoing Referrals list,
and click View

(i Details
ﬂl: Dedele  Referal Classes  Extemnal Provider Setup  Print of Export

Referrals
-
E.unan{ﬁm\enul Dt Provider Service Category Status Complete Date Class Comments Referral Type
Duilooing OT2TR020 Provider Agmq‘- E Food BankiHome-delriered Meals  Percing Extamial —
Incoming | 07222020 Provider Agency R Health insurance Program (HIF)  Pending ADWP Ienportant informabic Indeanal
Incoming OrEM2020 Provider Agency J Mon CARE Adl Service Compieled  §T232020 Dental Care Infemal

a. If you only want to view the referral, you can view the information from here, when
finished, select Back

b. If you want to edit or add information, or close the referral you will need to select
Edit

View Details > View

View




5. Complete the referral, and update all fields as required by your agency’s policies and
procedures.

6. Select Save
a. The Referral Status must be resolved to Pending, Lost to follow-up, or Rejected
within 30 days of the Referral Date. Scroll down and click Save when you are done.
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